Волнующее море в Фотошоп

В этом уроке вы узнаете, как создать фотоманипуляцию с помощью нескольких стоковых изображений, как создать мрачную атмосферу и как применить светотени к изображению. Вы также узнаете различные способы цветовой коррекции, чтобы получить именно то изображение, которые вы хотели. Давайте приступим!

Итоговый результат





Исходные материалы:
Верхняя часть Заднего фона
Море
Камень
Небо
Девушка
Очертания камня
Кисти Волны
Кисти Туман
Облака
Кисти Птицы
ШАГ 1. Создайте новый документ в программе Photoshop. Установите размеры 600px (по ширине) и 900px (по высоте). Скачайте изображение заднего фона и переместите на только что созданный документ. Назовите этот слой, например, Верхняя Часть Заднего Фона.

Для соответствия размерам документа, нажмите клавиши Ctrl + T или через меню, идём Редактирование – Свободная Трансформация (Edit > Free Transform) и масштабируем в соответствии с размерами документа. При масштабировании, удерживайте клавишу Shift, чтобы сохранилось соотношение пропорций. Чтобы применить изменения, нажмите клавишу Enter.

Расположите слой Верхняя Часть Заднего Фона в верхней части изображения.
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Мне нравится общая безмятежная атмосфера изображения. Это загадочное, туманное настроение, которое я нахожу, особенно привлекательным. Но мне также нравится драматизм в своих изображениях. Чтобы придать немного драматизма здесь, вам нужно создать более высокие горы на левой и правой стороне.

Выберите инструмент Лассо [image: image2.png]


(Lasso Tool (L) и выделите правую часть гор. Нажмите Ctrl + C, чтобы скопировать выделение, а затем нажмите Ctrl + V, чтобы вклеить скопированное выделение. Назовите новый слой ПРАВЫЕ ГОРЫ и расположите слой поверх слоя с оригинальными горами. На скриншоте ниже, вы можете увидеть пример того, что я имею виду.
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Как вы видите, изображение сейчас выглядит не очень реалистично. Чтобы изображение выглядело лучше, вам необходимо совместить его с остальным изображением.

Вы могли бы это сделать с помощью инструмента Ластик [image: image4.png]


(Eraser Tool (E), но у меня есть лучше идея для вас- использовать слой- маску. Когда вы применяете ластик, обработанные ластиком области теряются навсегда и очень сложно потом их восстановить, если в какой-то момент вы решили что-то переделать. Когда вы работаете со слой-масками, те части или области, которые были скрыты (не удалены), легко вновь восстановить.

Принцип – прост: если вы хотите что-то скрыть, прокрасьте на слой-маске чёрной кистью поверх скрываемой области, если вы хотите, чтобы что-то стало видимым, прокрашиваете на слой- маске белой кистью.

Убедитесь, что вы стоите на слое ПРАВЫЕ ГОРЫ. В нижней панели настроек нажмите кнопку Добавить слой-маску [image: image5.png]


(Add layer mask). Вы можете найти эту кнопку в нижней части палитры слоёв, если вы не видите палитру слоёв, то нажмите клавишу F7 или активируете через Окно – Слои (Window > Layers) и тогда появится палитра слоёв.
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Выберите инструмент Кисть [image: image7.png]


(Brush Tool (B), выберите мягкую круглую кисть, размер кисти установите примерно 70 px., уменьшите непрозрачность кисти до 40% и установите цвет кисти - чёрный. Убедитесь, что у вас активна слой- маска (щёлкните по ней) и начните обрабатывать ПРАВЫЕ ГОРЫ, создавая плавный переход с задним фоном.
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Сейчас, проделайте точно такое же действие с левой частью гор. На скриншоте ниже, вы можете увидеть, как изображение должно выглядеть после этого шага.
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ШАГ 2. Скачайте стоковое изображение Море по ссылке вначале урока и переместите изображение на наш документ. Назовите новый слой МОРЕ. Нажмите Ctrl + T, чтобы поменять размеры изображения в соответствии с размерами документа. Нажмите Enter, чтобы применить изменения.
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Вам необходимо совместить МОРЕ с остальным изображением. Проделайте то же самое, что вы проделывали с горами в предыдущем шаге. Добавьте слой- маску и с помощью кисти создайте плавный переход между морем и скалами. Примените те же самые настройки для кисти, что и в предыдущем шаге. Прокрашивайте до тех пор, пока у вас не получится плавный мягкий переход. На скриншоте ниже, вы можете увидеть, как должны выглядеть совмещённые изображения.
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Необходимо добавить ещё один элемент на передний план, это камень, на котором будет сидеть девушка. Скачайте изображение камня по ссылке вначале этого урока. Переместите данное изображение на наш документ, расположите слой с камнем поверх всех слоёв, примените масштабирование и далее переименуйте этот слой в КАМЕНЬ.

Как и с предыдущими частями заднего фона, вам необходимо правильно совместить камень с остальным изображением. Для этого, добавьте слой- маску к слою с камнем. Выберите мягкую круглую кисть, размер кисти установите 150 px, уменьшите непрозрачность кисти до 50%, а цвет кисти установите чёрный. Пройдитесь кистью поверх участков камня, которые вы хотите скрыть. На  скриншоте ниже, вы можете увидеть, как выглядит обработанный слой со слой- маской.
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Вот так должно выглядеть всё изображение на данный момент.
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ШАГ 3. В этом шаге мы сфокусируемся на коррекции неба. На данный момент, оно слишком светлое, что не подходит под то настроение, которое мы хотим создать  с помощью этой работы. В этом шаге мы немного затемним небо и проведём ещё несколько коррекций в следующих шагах.

Скачайте изображение НЕБО по ссылке вначале этого урока, а затем переместите изображение с небом на наш документ. Расположите слой с небом поверх всех слоёв, а затем назовите этот слой НЕБО. Нажмите Ctrl + T или через меню, идём Редактирование – Свободная Трансформация (Edit > Free Transform) и масштабируем в соответствии с размерами документа. Нажмите Enter, чтобы применить изменения.

Вам нужно сделать две вещи, это правильно совместить этот слой с остальным изображением  т.е. нужно поменять режим наложения и провести дальнейшее совмещение с помощью слой- маски.

Давайте начнём с режима наложения. Меню Режимов наложения расположено в верхней части палитры слоёв. Поменяйте режим слоя с небом на Умножение (Multiply), а затем уменьшите непрозрачность слоя до 50%, чтобы получить более нежный эффект.
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Добавьте слой- маску к слою НЕБО и проведите совмещение так же, как вы это проводили в предыдущих шагах.

На скриншоте ниже, Вы можете сравнить, как выглядит изображение ДО и После этого шага.
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Давайте посмотрим, как должен выглядеть порядок слоёв:
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ШАГ 4. Этот шаг очень быстрый. Скачайте стоковое изображение девушки, а затем переместите изображение с девушкой на наш документ. Расположите слой с девушкой поверх всех слоёв, а затем назовите этот слой ДЕВУШКА. Нажмите клавиши Ctrl + T для масштабирования для соответствия размеров. Далее, нажмите Enter, чтобы применить изменения.

На скриншоте ниже, вы можете увидеть, как должно выглядеть изображение на данный момент.
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ШАГ 5. Как вы заметили, обе стороны камня, на котором сидит девушка, выглядят слишком странно из-за слишком плавных краёв. Но вы не переживайте, в этом шаге мы добавим очертания лиц на каждую сторону камня, чтобы исправить это.

Скачайте стоковое изображение очертаний лиц, далее откройте изображение в программе Photoshop. Удалите задний фон. Вы можете использовать инструмент Лассо [image: image18.png]


(Lasso Tool (L) или Перо [image: image19.jpg]


(Pen Tool (P) или любую другую технику, которая более комфортна для выделения объектов. Далее, переместите лицо на наш документ. Назовите этот слой ПРАВОЕ ЛИЦО, расположите слой поверх всех слоёв. Нажмите Ctrl + T для масштабирования в соответствии с размерами.

Чтобы лучше совместить очертание лица с остальным изображением – поменяйте режим наложения на Перекрытие (Overlay).
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На скриншоте ниже, вы можете сравнить, как выглядит лицо при режимах наложения Нормальный (Normal) и Перекрытие (Overlay).
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Мы также хотим создать очертание лица на левой стороне камня. Щёлкните правой кнопкой мыши по слою ПРАВОЕ ЛИЦО и выберите опцию Создать дубликат слоя (Duplicate layer). Назовите этот слой ЛЕВОЕ ЛИЦО (LEFT FACE). Вам нужно отразить по горизонтали этот дубликат изображения лица, для этого идём Редактирование – Трансформация – Отразить по горизонтали (Edit > Transform > Flip Horizontal). Выберите инструмент Перемещение [image: image22.png]


(Move Tool (V) и переместите дубликат лица в левую часть изображения.

ШАГ 6. Если вы сейчас посмотрите на изображение, то вы увидите, что очертания лиц слишком светлые и поэтому не соответствуют по оттенкам с остальным изображением. В этом шаге мы сделаем их темнее.

Добавьте новый корректирующий слой Уровни (Levels) поверх слоя ПРАВОЕ ЛИЦО, но ниже слоя ЛЕВОЕ ЛИЦО. Кнопку Создать новый корректирующий слой или слой-заливку [image: image23.png]


(Add new fill or adjustment layer) вы можете найти в нижней части палитры слоёв, рядом с кнопкой Слой-маски (Layer mask), опцию которую вы применяли в предыдущем шагах.
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Я настоятельно рекомендую вам использовать корректирующие слои вместо прямой коррекции, когда вы заходите через Изображение – Коррекция …..тип коррекции (Image > Adjustments > … path). Когда вы применяете корректирующие слои, то в этих случаях, вы можете легко вернуться обратно и исправить коррекцию или просто удалить корректирующий слой или провести только локальные изменения.
 
Поэтому, к слою ПРАВОЕ ЛИЦО примените корректирующий слой Уровни (Levels), примените Входные значения (Input Levels) 9; 0,21; 255 и Выходные значения (Output Levels) 17; 142.
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Как вы видите,  все слои, расположенные ниже корректирующего слоя (в данном случае, все слои, кроме слоя ЛЕВОЕ ЛИЦО, который расположен выше) находятся под действием корректирующего слоя. И мы этого не хотим, мы хотим, чтобы коррекция была применима только к слою ПРАВОЕ ЛИЦО.

К счастью, есть очень быстрое решение для Вас! Щёлкните правой кнопкой по корректирующему слою, который мы только что создали и выберите опцию Создать обтравочную маску (Create Clipping Mask). Данная опция применит коррекцию только к слою ПРАВОЕ ЛИЦО и сделает его темнее.
 
Давайте перейдём к слою ЛЕВОЕ ЛИЦО. Добавьте корректирующий слой Уровни (Levels) к слою ЛЕВОЕ ЛИЦО, корректирующий слой должен быть поверх всех слоёв. Примените те же самые настройки, что и для слоя ПРАВОЕ ЛИЦО (см. скриншот ниже).  Для коррекции только слоя ЛЕВОЕ ЛИЦО, а не ко всему изображению, щёлкните правой кнопкой по корректирующему слою и ещё раз выберите опцию Создать обтравочную маску (Create Clipping Mask).

На скриншоте ниже, вы можете увидеть, как должно выглядеть изображение на данный момент.
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ШАГ 7. Большинство основных элементов композиции уже размещено на изображении. Поэтому с этого момента мы сфокусируемся над созданием атмосферы картины. Если вы сейчас посмотрите на изображение, то вы найдёте её слишком скучной  -  отсутствует некая динамика, отсутствуют интересные световые эффекты, те два элемента, которые действительно полезны при добавлении драмы к вашей композиции.

В этом шаге, давайте приступим к созданию более интересных световых эффектов.

Создайте новый корректирующий слой Уровни (Levels) поверх всех слоёв и примените следующие Входные значения (Input Levels) 0; 2.83; 255.
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Сейчас вы увидите еще одну причину, почему нужно использовать слой маски, а не прямую коррекцию - локальные изменения.

Выберите инструмент Заливка [image: image28.png]


(Paint Bucket Tool (G), установите цвет чёрный. Щёлкните по слой-маске корректирующего слоя и залейте слой-маску чёрным цветом. Коррекция исчезнет.
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Это тот же принцип, который вы использовали при совмещении изображений с задним фоном в самом начале урока. Тогда вы использовали черную кисть, чтобы скрыть ненужные участки. В это раз вы примените белую кисть, чтобы проявилась коррекция на определённых участках, которые должны быть светлее, чем те, которые сейчас.

Выберите инструмент Кисть [image: image30.png]


(Brush Tool (B), выберите мягкую круглую кисть размером 10px – 20 px. Уменьшите непрозрачность кисти до 5% и установите цвет кисти – белый. Начните прокрашивать участки, которые вы хотите, чтобы были светлее. Этот процесс был бы проще и быстрее, если бы у вас был планшет, но если у вас есть небольшая практика, то вы также успешно справитесь с помощью мышки.
 
Вы должны сфокусироваться на щеках девушки и её руках, на волнах, горах на заднем фоне и на очертаниях лиц на камне во время работы кистью. На скриншоте ниже в качестве примера, я выделил участки красным цветом, где я применил кисть.
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ШАГ 8. Логически правильно будет сразу после коррекции света, провести коррекцию теней, поэтому, давайте приступим!

Создайте новый корректирующий слой Уровни (Levels) поверх всех слоёв и на этот раз примените Входные значения (Input Levels) 0; 0.19; 255.
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Выберите инструмент Заливка [image: image33.png]


(Paint Bucket Tool (G), установите цвет чёрный и залейте слой- маску чёрным цветом. Далее, выберите кисть, примените те же настройки, что и в предыдущем шаге (не забудьте установить цвет кисти белый) и начните прокрашивать поверх участков, где должны быть более насыщенные тени – нижняя часть платья девушки, верхняя часть неба, противоположная сторона гор и очертаний лиц.
 
Так же как и в предыдущем шаге, я выделил участки, где я применил кисть, чтобы вы имели представление, где применять кисть.
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После этих двух шагов, ваше изображение должно выглядеть, как на скриншоте ниже.
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ШАГ 9. В предыдущих шагах, мы придали изображению немного драмы с помощью коррекции световой сцены изображения. Сейчас, давайте, сфокусируемся на некой динамике.

Если вы посмотрите на море, то оно очень спокойное и умиротворённое. Было бы более драматичным, если бы было больше волн? Мы добавим волны в этом шаге.

Скачайте кисти Волны по ссылке вначале урока и установите в программу Photoshop. Если вы не знаете, как устанавливаются дополнительные кисти, то вы можете посмотреть этот урок.

Создайте новый слой поверх всех слоёв, назовите этот слой ВОЛНЫ. Выберите инструмент Кисть[image: image36.png]


(Brush Tool (B) и выберите одну из кистей волны, которые вы только что установили. Нажмите клавишу Alt, чтобы активировать инструмент Пипетка [image: image37.png]


(Eye Dropper Tool (I) и выберите образцы самых светлых цветовых оттенков на изображении. Пытайтесь избегать использование чисто белых или чисто чёрных оттенков (это касается не только этого изображения, но и всех ваших других фото манипуляций). Оба оттенка – очень резкие и редко встречаются в реальности.

Если посмотрите вокруг себя, то вы заметите, что очень мало примеров обоих этих оттенков. Чаще встречаются вариации этих оттенков, например, светло-жёлтый, светло-голубой …..вместо белого и тёмно-зелёного и серый или коричневый вместо чисто чёрного.

Итак, просто нарисуйте волны вокруг камня, на котором сидит девушка. Давайте посмотрим, куда вы должны добавить волны.
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ШАГ 10. Если вы уже знакомы с большинством моих уроков, вы наверно уже знаете, что мне очень нравится добавлять туман к своим работам по фотоманипуляции. Причина в том, что, на мой взгляд, туман может придать слегка приятный штрих магической или загадочной атмосферы, и вот то, что мне действительно нравится в изображениях.

Создайте новый слой поверх всех слоёв, назовите этот слой ТУМАН. Скачайте кисти по ссылке вначале урока (или не стесняйтесь использовать другие кисти, которые можно скачать бесплатно) и установите их в программу Photoshop.

Выберите кисть, установите одну из кистей туман, которые вы только что установили. Нажмите клавишу Alt, чтобы активировать инструмент Пипетка[image: image39.png]


(Eye Dropper Tool (I) и выберите образцы очень светлых цветовых оттенков на изображении. Сейчас, просто нарисуйте лёгкий туман вокруг гор на заднем фоне.
 
Будьте аккуратны, не нарисуйте туман на девушке. Это не будет выглядеть реалистичным, потому что девушка находится на переднем плане, где нет тумана.
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ШАГ 11. В этом шаге мы осуществим три вещи – усилим контраст с помощью Карты градиента (Gradient Map), добавим синеватых оттенков с помощью Уровней (Levels) и немного уменьшим насыщенность кожи девушки с помощью корректирующего слоя Вибрация (Vibrance). Давайте приступим с усиления контраста.

Добавьте новый корректирующий слой Карта градиента (Gradient Map) поверх всех слоёв. Выберите чёрно-белый градиент.
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После применения градиента, изображение стало чёрно-белым. Но мы хотим усилить контраст, не правда ли? Для этого, просто поменяйте режим наложения для этого слоя на Свечение (Luminosity).

[image: image42.jpg]



На скриншоте ниже, вы можете увидеть как корректирующий слой Карта Градиента (Gradient Map) воздействует на изображение.

[image: image43.jpg]



Второе действие, которое мы проведём, это добавление синеватых оттенков. Для этого, создайте корректирующий слой Уровни (Levels) поверх всех слоёв. Выберите Синий канал (Blue channels) и установите Выходные значения (Output Levels) 19; 255.
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На скриншоте ниже, вы можете увидеть, как данная коррекция повлияла на изображение.
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Применим последнее действие – немного уменьшим насыщенность кожи девушки. Создайте новый корректирующий слой Вибрация (Vibrance) поверх всех слоёв, значение вибрации установите на -10.
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Если у вас стоит более ранняя версия Photoshop (я думаю CS2 или более ранняя), то в этих версиях нет опции Вибрация (Vibrance). Но вы можете добиться этого же эффекта с помощью корректирующего слоя Цветовой тон / Насыщенность (Hue/Saturation), в качестве цвета выберите Красный (Red) и установите значение  Насыщенности (Saturation) -10.
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Давайте посмотрим, как выглядит ваше изображение после применения всех этих шагов и коррекции.
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ШАГ 12. Из-за предыдущей коррекции, платье девушки стало слишком светлым, что не создаёт интересный контраст между одеждой и остальным изображением. Вы исправите это в этом шаге.

Создайте новый корректирующий слой Уровни (Levels) поверх всех слоёв и примените Входные значения (Input Levels) 25; 0.70; 255.
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Мы хотим провести коррекцию только платья девушки, а не всего изображения. Поэтому, нам необходимо залить слой-маску этого корректирующего слоя чёрным цветом, а потом кистью прокрасить участки, которые мы хотим затемнить.
 
Выберите инструмент Заливка [image: image50.png]


(Paint Bucket Tool (G), установите цвет чёрный, убедитесь, чтобы слой-маска была активна (просто щёлкните по миниатюре слой- маски), и залейте слой-маску чёрным цветом. Далее, выберите инструмент Кисть[image: image51.png]


(Brush Tool (B), установите круглую мягкую кисть, размер кисти установите примерно на 50 px, непрозрачность кисти установите на 100%. Установите цвет кисти белый и далее прокрасьте поверх платья, чтобы сделать платье темнее.

На скриншоте ниже, вы можете сравнить, как выглядит изображение до и после применения этого шага.
 
Это достаточно лёгкое изменение, но я твердо верю, что, при выполнении работ по фотоманипуляции вам необходимо провести несколько тонких коррекций вместо одной радикальной. Благодаря этому вы получите более естественный вид и более интересные образы.
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ШАГ 13. На мой взгляд, в композиции на данный момент до сих пор отсутствует драма, которую я хочу создать. Если мы сделаем горы на заднем фоне немного выше, то это может помочь. Для этого щёлкните правой кнопкой мыши по слою ПРАВАЯ ГОРА и выберите опцию Создать дубликат слоя (Duplicate layer). Назовите новый слой, например, ПРАВАЯ ГОРА II и расположите этот слоя поверх всех слоёв. Выберите инструмент Перемещение [image: image53.png]


(Move Tool (V) и переместите гору выше, так, чтобы она казалась выше.
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Чтобы правильно совместить слой с остальным изображением, добавьте к слою слой- маску. Выберите инструмент Кисть [image: image55.png]


(Brush Tool (B), установите размер кисти примерно на 30 px и уменьшите непрозрачность кисти до 50%. Установите цвет кисти белый и на слой- маске прокрасьте белой кистью вдоль края горы, чтобы создать плавный переход.

Далее, проделайте то же самое с левой стороной горы.

На скриншоте ниже. Вы можете увидеть, как должно выглядеть изображение на данный момент.
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ШАГ 14. На мой взгляд, на небе мало деталей и из-за этого оно выглядит скучным. В этом шаге мы добавим штормовые, более драматичные облака. Скачайте изображение облаков по ссылке вначале урока. Расположите этот слой поверх всех слоёв, назовите этот слой ОБЛАКА. Нажмите клавиши Ctrl + T для масштабирования изображения в соответствии с размерами документа. Далее, нажмите клавишу Enter, чтобы применить изменения.

Чтобы правильно совместить облака с остальным изображением, поменяйте режим наложения на Перекрытие (Overlay).
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Если вы посмотрите на скриншот ниже, то вы можете заметить грубый переход между добавленными облаками и остальным изображением.

Нам нужно создать плавный переход. Для этого, добавьте слой- маску к слою с ОБЛАКА. Выберите кисть, установите мягкую круглую кисть размером примерно 100 px и уменьшите непрозрачность кисти до 50%. Установите цвет кисти чёрный и прокрасьте кистью вдоль перехода, чтобы создать плавное совмещение.
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ШАГ 15. Общая картина выглядела бы лучше, если бы небо было немного темнее. Мы проведём коррекцию неба в этом шаге. Создайте новый корректирующий слой Уровни (Levels) поверх всех слоёв и примените Входные значения (Input Levels) 15; 0.90; 250.
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Нам нужно провести коррекцию только одного слоя (ОБЛАКА), а не всего изображения. Для этого, щёлкните правой кнопкой мыши по корректирующему слою Уровни (Levels) и выберите опцию Создать обтравочную маску (Create Clipping Mask).

Чтобы добавить ещё больше глубины небу, немного затемните верхнюю часть. Создайте ещё один корректирующий слой Уровни (Levels) поверх всех слоёв и на этот раз примените Входные значения (Input Levels) 0; 0.45; 255.
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Мы хотим провести коррекцию только верхней части неба. Для этого, выберите инструмент Заливка[image: image61.png]


(Paint Bucket Tool (G), установите цвет чёрный и залейте слой –маску этого корректирующего слоя чёрным цветом. Далее, выберите кисть, примените те же настройки для кисти, что вы использовали в предыдущем шаге. Установите непрозрачность кисти до примерно 30% и установите цвет кисти белый. Итак, прокрасьте поверх верхней части неба. На скриншоте ниже, вы можете представить, где обрабатывать кистью, эти участки выделены красным цветом.
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Ваше изображение должно выглядеть, как на скриншоте ниже.
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ШАГ 16. Это будет самый быстрый шаг. Я уже упоминал, что я люблю использовать туман в своих работах, т.к. он создаёт загадочную атмосферу. Другой любимый элемент - это летающие птицы, они придают некую динамику изображению. В этом шаге мы добавим птиц.
 
Скачайте кисти Птицы по ссылке вначале урока и установите их в программу Photoshop. Создайте новый слой поверх всех слоёв, назовите этот слой ПТИЦЫ. Выберите кисть, установите одну из кистей, которые вы только что установили. Удерживая клавишу Alt, чтобы активировать инструмент Пипетка[image: image64.png]


(Eyedropper Tool (I) и выберите образцы тёмно-синего оттенка на изображении. Нарисуйте несколько птиц! Не рисуйте слишком много птиц, т.к. это не будет выглядеть реалистично.
 
ШАГ 17. Давайте перейдём к следующему шагу. В этой заключительной части, мы сфокусируемся над созданием более интересной атмосферы, с помощью серии корректирующих слоёв мы проведём коррекцию цветовых оттенков.

Давайте начнём с затемнения некоторых участков изображения. Создайте новый слой поверх всех слоёв, назовите этот слой, например, ЗАТЕМНЕНИЕ. Поменяйте режим наложения на Мягкий свет (Soft Light).
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Выберите инструмент Кисть [image: image66.png]


(Brush Tool (B), установите мягкую круглую кисть размером примерно 30 px. Уменьшите непрозрачность кисти до 10% и установите цвет кисти чёрный. Прорисуйте поверх некоторых участков облаков, чтобы сделать их немного темнее и драматичнее.
 
Затем, поменяйте цвет с чёрного на белый и прокрасьте кистью поверх гор, чтобы создать более интересный световой эффект. На скриншоте ниже, вы можете увидеть, где прорисовывать кистью.

[image: image67.jpg]



ШАГ 18. На мой взгляд, общая атмосфера «морской» картины должна быть пронизана больше бирюзовыми / синими оттенками. В этом шаге мы добавим эти оттенки.

Создайте новый слой поверх всех слоёв, назовите этот слой БОЛЬШЕ БИРЮЗВЫХ ОТТЕНКОВ. Выберите инструмент Заливка [image: image68.png]


(Paint Bucket Tool (G) и установите цветовые оттенки бирюзового или синего цвета. Если вы хотите использовать тот же цветовой оттенок, который использовал я, введите номер оттенка в выделенное окошко.
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Используя этот слой для коррекции цветовых оттенков, поменяйте режим наложения на Мягкий свет (Soft Light), чтобы получить плавный и нежный эффект, уменьшите непрозрачность до 25%.
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Давайте посмотрим, как должно выглядеть ваше изображение на данный момент.
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ШАГ 19. В этом шаге мы проведём две нежные коррекции. Мы сделаем изображение немного темнее и добавим чуть больше контраста.

Давайте начнём с затемнения. Создайте новый корректирующий слой Уровни (Levels) поверх всех слоёв, примените Входные значения (Input Levels) 5; 0.95; 255.
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Чтобы усилить контраст, создайте новый корректирующий слой Карта градиента (Gradient Map) поверх всех слоёв. Выберите чёрно-белый градиент.
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Поменяйте режим наложения на Свечение (Luminosity). Чтобы получить более нежный и реалистичный эффект, уменьшите непрозрачность корректирующего слоя до 30%.
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ШАГ 20. Давайте сфокусируемся на нижней части изображения из-за отсутствия контраста. В настоящий момент, камень на переднем плане такой же светлый, как и море, поэтому камень не выглядит интересным. Также, нижняя часть платья должна быть немного темнее  - эта часть платья влажная, а вещи, как правило, из-за влажности становятся темнее.

Создайте новый корректирующий слой Уровни (Levels) поверх всех слоёв, примените Входные значения (Input Levels) 0; 0.5; 255.
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Мы хотим провести только локальную коррекцию. Поэтому, выберите инструмент Заливка [image: image76.png]


(Paint Bucket Tool (G), установите цвет чёрный и залейте слой –маску чёрным цветом. Затем, выберите кисть, установите цвет кисти белый и начните прокрашивать поверх участков, которые вы хотите затемнить.

На скриншоте ниже, вы можете увидеть, где прокрашивать кистью. Эти участки выделены красным цветом.
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Платье должно быть еще темнее. Для этого, создайте новый корректирующий слой Цветовой тон/ Насыщенность (Hue/Saturation) поверх всех слоёв, установите настройки, как показано на скриншоте ниже.
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Как и ранее, мы хотим провести только локальную коррекцию. Залейте слой-маску этого нового корректирующего слоя чёрным цветом. Далее, выберите кисть, установите цвет кисти на белый и прокрасьте поверх участков, которые отмечены красным цветом на скриншоте ниже.
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ШАГ 21. Ещё один быстрый шаг, в котором мы затемним световые блики. Создайте новый корректирующий слой Уровни (Levels) поверх всех слоёв и примените Выходные значения (Output Levels) 0; 235.
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На скриншоте ниже, вы можете сравнить, как выглядит изображение до и после проведения этой коррекции.
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ШАГ 22. Меня не устраивает цвет платья. Оно слишком светлое и слишком красное. Мы исправим это в этом шаге.

Создайте новый корректирующий слой Выборочная коррекция цвета (Selective Color) поверх всех слоёв. В окне Цвета (Color) выберите опцию Красный (Red) и примените те же настойки, как на скриншоте ниже.
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Рука и лицо девушки слишком подверглись воздействию коррекции и это выглядит не очень хорошо из-за перенасыщения оттенками синего. Чтобы скрыть на них коррекцию, выберите инструмент кисть, установите цвет кисти чёрный, щёлкните по миниатюре слой- маски и просто прокрасьте кистью поверх рук и лица.

На скриншоте ниже, вы можете сравнить, как изображение выглядит, когда кожа девушки (подвергнута воздействию Выборочной коррекции цвета (Selective Color) (ДО) и после того, как мы скрыли коррекцию на слой- маске (ПОСЛЕ).
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ШАГ 23. Это последняя локальная коррекция, которую нам необходимо провести, перед тем, как мы завершим урок. Кожа девушки кажется слишком светлой. Чтобы исправить это, создайте новый корректирующий слой Уровни (Levels) поверх всех слоев и примените Входные значения (Input Levels) 0; 0.8; 255 и Выходные значения (Output Levels) 25; 255.
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Чтобы провести коррекцию только кожи девушки, залейте слой- маску этого слоя чёрным цветом. Далее, выберите кисть, установите цвет кисти белый и прорисуйте поверх участков, которые вы хотите затемнить. На скриншоте ниже, вы можете увидеть, где прорисовывать кистью, эти участки выделены красным цветом.
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ШАГ 24. Это последний шаг, это самый быстрый и лёгкий шаг. Мы сделаем изображение немного светлее.

Создайте новый корректирующий слой Уровни (Levels) поверх всех слоёв и примените Входные значения (Input Levels) 0; 1.00; 240.

И мы закончили урок!
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Итоговый результат
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